EcoMATE™ Handbook

Electronic Fuel Management System
## Version List

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Changes</th>
<th>Changed</th>
<th>Approved</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>25.10.2016</td>
<td>Public version</td>
<td>HTJ</td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>21.11.2016</td>
<td>Added Ch. 2 Operational Limitations</td>
<td>HTJ</td>
<td></td>
</tr>
<tr>
<td>1.2</td>
<td>13.12.2016</td>
<td>Modified according to Verifavia input</td>
<td>HTJ</td>
<td></td>
</tr>
<tr>
<td>1.3</td>
<td>21.09.2017</td>
<td>Added functions and changes for software version 1.0.5</td>
<td>MKN</td>
<td>AT</td>
</tr>
<tr>
<td>1.4</td>
<td>25.01.2018</td>
<td>Changed pictures and added functions for version 1.0.8</td>
<td>MKN</td>
<td></td>
</tr>
</tbody>
</table>
### 7.3 Alarm Status

### 8 How To

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1 POPUP AN OBJECT FACEPLATE</td>
<td>57</td>
</tr>
<tr>
<td>8.2 EDIT ALARM SETTINGS</td>
<td>58</td>
</tr>
<tr>
<td>8.3 HOW TO GET STARTED</td>
<td>59</td>
</tr>
<tr>
<td>8.4 HOW TO INSTALL OR UPGRADE THE SOFTWARE AND RENEW A LICENSE KEY</td>
<td>60</td>
</tr>
<tr>
<td>8.5 HOW TO EDIT AND CHANGE FUEL TYPE FOR A CONSUMER</td>
<td>63</td>
</tr>
<tr>
<td>8.6 HOW TO REGISTER OR EDIT A VOYAGE (METHOD A)</td>
<td>64</td>
</tr>
<tr>
<td>8.7 HOW TO REGISTER OR EDIT A VOYAGE (METHOD B)</td>
<td>65</td>
</tr>
<tr>
<td>8.8 HOW TO REGISTER OR EDIT A VOYAGE (METHOD C)</td>
<td>66</td>
</tr>
<tr>
<td>8.9 HOW TO CREATE AND DISTRIBUTE A REPORT</td>
<td>67</td>
</tr>
<tr>
<td>8.10 HOW TO TREND AND ANALYSE HISTORICAL DATA</td>
<td>68</td>
</tr>
<tr>
<td>8.11 HOW TO MONITOR AND REPORT A BUNKERING OPERATION</td>
<td>69</td>
</tr>
</tbody>
</table>

### 9 Appendices

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.1 APPENDIX 1: CALCULATIONS</td>
<td>71</td>
</tr>
<tr>
<td>9.1.1 Energy Efficiency Design Index (EEDI)</td>
<td>71</td>
</tr>
<tr>
<td>9.1.2 Estimated Index Value (EIV)</td>
<td>71</td>
</tr>
<tr>
<td>9.1.3 Momentary CO₂</td>
<td>71</td>
</tr>
<tr>
<td>9.1.4 Momentary SO₂</td>
<td>71</td>
</tr>
<tr>
<td>9.1.5 Momentary NOₓ</td>
<td>71</td>
</tr>
<tr>
<td>9.1.6 Transport Work</td>
<td>72</td>
</tr>
<tr>
<td>9.1.7 Average Energy Efficiency</td>
<td>72</td>
</tr>
</tbody>
</table>
1 INTRODUCTION

This document describes the Human Machine Interface (HMI) and run-time operation of the EcoMATE™ system for Monitoring, Reporting and Verification of fuel consumption and emissions and/or bunkering from KROHNE Marine. Configuration and setup is documented separately.

The full version of the EcoMATE™ system is described in the following. Note that an alternative software version only for manual voyage registration and reporting is also available (without flow meters, dedicated I/O computer, RAID disks, external inputs, historian database etc.). Several HMI elements will be disabled or invisible in this version.

Start the application by clicking the “Monitoring System Client” icon on the desktop. The recommended screen resolution is 1920x1080 (Full HD). If you have a typical “How to” question, go straight to the step by step procedures listed in chapter 8. Alternatively, search for a specific topic by pressing Ctrl + F.
2 OPERATIONAL LIMITATIONS

The system is based on the following operational limitations:

1. The EcoMATE™ software is available in English language.
2. The system can be setup in two modes:
   o Manual registration and reporting of voyages according to EU regulation 2015/75 based on monitoring methods A (BDN and periodic stocktakes of fuel tanks) and B (Bunker fuel tank monitoring on-board).
   o The above, including live monitoring and historical logging of fuel consumption and emissions based on a dedicated I/O computer with a historian database, mass flow meters installed, external inputs and a configuration model for relevant equipment with layout drawings and calculations as the basis for method C (Flow meters for applicable combustion processes).
3. Configuration of any model is performed by KROHNE Marine or qualified personnel via a separate configuration tool.
4. The following monitoring methods are available:
   o Method A: BDN and periodic stocktakes of fuel tanks.
   o Method B: Bunker fuel tank monitoring on-board
   o Method C: Flow meters for applicable combustion processes.
5. The monitoring method is selected globally, and will be applied to all relevant consumers, i.e. not individual / different methods for each single consumer.
6. Note that each voyage registration will be based on the selected monitoring method at the time of creation. If the global monitoring method is changed, this will only affect subsequent voyage registrations.
7. If Method C is selected, all consumers must be connected to installed mass flow meter(s).
8. It is assumed that the ship immediately leaves berth when a new voyage starts, and that the “At berth” contribution to the total fuel consumption and emissions will be registered at the end of each voyage (and accounted for only for voyages into or within EU).
9. Voyage summary data is calculated according to the following:
   o Distance sailed: Total distance in nautical miles from berth-to-berth, i.e. between the Left berth and Arrived at berth events.
   o Time at sea: Total time between the Left berth and Arrived at berth events, excluding any Sea passage interrupted / recommenced time periods.
   o At berth: Time period between the Arrived at berth event and the registered End time of the current voyage (usually the Start of next voyage)
10. Cargo carried has to be entered in mass (Tons) for all ship types, and might have to be calculated from volume, density, container TEU, area etc. outside this application.
11. In the same way, any split between passenger and freight part (for ro-pax ship) must be calculated based on appropriate methods and typed in (%) for each voyage.
3 SYSTEM DESCRIPTION

The EcoMATE™ system is based on:

- Reliable and accurate KROHNE flow meters.
- One master computer running Microsoft Windows operating system, with a preconfigured installation for the actual vessel.
- Optional input from external systems.
- Operator inputs via HMI.
- Internal calculation of key data.
- Online monitoring.
- Database storage of historical data.
- Backup of database and historical data to USB disk.
- Flexible reporting tools with optional printout.
- Optional Summit 8800 Flow Computer for bunkering calculations.
- Optional Gateway for data distribution to external systems.
- Optional HMI clients for distributed display.

Figure 1: EcoMATE™ system.
The EcoMATE™ modules:

- EcoMATE™ Fuel Consumption Module for continuous measurement and monitoring of fuel consumption on board ships.
- EcoMATE™ Bunkering Module for verification of the bunker quantities received through the bunker line.
- EcoMATE™ MRV Module for Monitoring, Reporting and Verification of CO₂ emissions and energy efficiency according to EU regulation 2015/757.
- EcoMATE™ Cloud Module for transmitting of data to shore for fleet reporting and monitoring. (Described in separate user manual)
4 VIEWS

The top area of the application is always visible, and consists of the following main elements:

- **Navigation tabs**: Navigate to the application’s main views (see chapter 4).
- **Menu bar**: Popup various windows and utilities (see chapter 5).
- **Date & Time**: Live clock showing current UTC date and time according to the host computer’s language and format settings.
- **Alarm status**: Displays an alarm status summary for the overall configuration, summarising the number of alarms present, grouped by severity / priority:

  ![Alarm Status Diagram]

  *Figure 3: Number of critical (red), high (yellow), medium (cyan) and low (blue) priority alarms present, grey if none.*

Optional functions available with EcoMATE™ Cloud module and NMEA data from on-board external input:

- **Vessel Mode**: Manual selectable vessel mode.
- **Position**: Longitude and Latitude position data received from NMEA.
- **Speed**: Speed over ground data received from NMEA.
4.1 Dashboard

The Dashboard view shows key data regarding the current fuel operation:

Figure 4: Dashboard view.

The following widgets are displayed:

4.1.1 Momentary values

The momentary values widget displays gauges with live value, quality, display unit, range and description for the following tags:

- Total momentary fuel consumption
- Total momentary CO₂ emission
- Total momentary SOx emission
- Total momentary NOx emission
- Speed through water (if configured and received from NMEA)
- Performance (if configured and received from NMEA)
4.1.2 Fuel changes

The fuel changes widget shows the currently selected fuel type for each of the fuel consumers registered in the system, as well as past changes indicated by coloured lines for each time period and fuel type. Click the combo box to change.

Move the mouse over a line segment to see total fuel consumed and CO₂, SOx and NOx emissions for a specific consumer fuel time period:
A legend for the fuel types and colours in use is displayed according to the fuel type settings described in section 5.1.2.

Use the scrollbar or mouse wheel to navigate in time, alternatively, click the heading to select among predefined time periods.

### 4.1.3 Fuel consumption history

The fuel consumption history shows a historical trend of the measured total momentary fuel consumption. Select among predefined time periods by clicking the heading.

![Figure 8: Select time period.](image)

Within this trend, select a custom time period by moving the left and right side blue handles with the mouse, alternatively click inside the time frame and drag it along the trend to generate a fuel and emissions summary, displayed below the trend:

![Figure 9: A pie chart indicating a percentage split of various fuel types used including a color legend.](image)
Figure 10: Total accumulated and average momentary fuel used, as well as CO₂, SOx and NOx emitted.

Click the report icon to generate and preview a fuel consumption report for the selected time period (see 4.4.3 for report details).

4.2 Layout

The layout view shows a drawing of the current configuration with graphical symbols and connectors etc. Main objects are represented by an interactive symbol with live values, and further information is available by clicking the symbol to pop up a corresponding faceplate window (if any).

Figure 11: Layout view – Consumption example.

Click the drawing heading to load among available drawings.
Figure 12: Layout view – Bunker example.
4.2.1 Symbols

Equipment and objects are typically represented by a graphical symbol with tag name, live values and alarm indicators:

- **Tag name**: Configured name of an object instance.
- **Description**: Descriptive text for an object.
- **Status**: Current operational status for an object (consuming, active etc.).
- **Symbol**: Graphical representation of the equipment (custom pictures can be loaded from the configuration tool).
- **Value**: Live value with description, format and display unit (specified in the configuration tool).
- **Bad value**: Bad values (I/O, out of range, initializing etc.) are represented with a red indicator. See mouse over tooltip for details.
- **Alarm status**: Aggregated alarm status is indicated for 1) the entire object and 2) individual tag values, showing the highest severity / priority currently present (critical red, high yellow, medium cyan and low blue).
- **Border**: Click inside the mouse-over border to pop up the corresponding faceplate with details (if any).

*Figure 13: Typical layout symbol*
4.2.2 Faceplates

A detailed faceplate is available for most of the configured equipment by clicking the layout symbol or double-clicking the tag name in the object explorer (see 4.2.3):

Figure 14: Typical faceplate (Overview, Trend and Service views).

Each faceplate typically consists of a custom tab (Overview) for the actual equipment type, as well as a number of common tabs (Trend, Service etc.) for most objects.

An overall alarm status for the equipment is displayed in the upper right corner, summarizing the number of alarms present, grouped by severity / priority.
Overview

The Overview tab displays key values using various graphical elements, further described in chapter 7. It may also contain interaction elements like combo boxes for selection of fuel type, totalizer start / stop buttons etc. The symbols of any internal child objects (totalizer, selector, calculation etc.) appear at the bottom of the tab, click to explore further.

Trend

The Trend view initially displays one or more trends of key tags for the actual object. Click the combo box “Select tag” to select / deselect among available tags for the equipment to add or remove trends. Tag name, colour and display unit of selected trends are indicated in the legend.

Select among preconfigured time periods (e.g. “5 minutes”) in the combo box at the bottom.
Note that tags configured with history will be display with historical data. Otherwise, the trend will be visible and build up temporary history only when the window is open.

Service

The Service tab gives a detailed picture of all tags, alarms and attributes for the object respectively. These can be modified via the configuration tool, described in a separate document. Selected service settings can be modified in run-time as well when allowed via the configuration.

Tags

The Tags represent the object’s most advanced variables with features like external input source, storage to history database etc. The following information is provided in run-time:

<table>
<thead>
<tr>
<th>Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Name</td>
<td>A short tag name, used in displays with limited space (read-only).</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the tag (read-only).</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the tag (read-only).</td>
</tr>
<tr>
<td>Value</td>
<td>Current value in display units (read-only unless manual).</td>
</tr>
</tbody>
</table>
Unit: Configured display unit (read-only).
Quality: The quality of the displayed value (good / bad, read-only).
Manual: Flag to allow input of a manual value.
Range: Flag whether to indicate bad value when value is outside the range or not.
On: Minimum range limit in display units.
Min: Maximum range limit in display units.
Input Source: The configured input source for the actual tag (if any).
Scaling: Flag whether input will be scaled or not.
Raw Min: Minimum raw input value.
Raw Max: Maximum raw input value.
Base Min: Minimum internal base value.
Base Max: Maximum internal base value.
Base Value: Current value in base units (read-only).
Unit: The base unit of the tag (read-only).

Alarms

The Alarms view lists limit (HiHi, Hi, Lo, LoLo) and state (high, low) alarms configured for the object's tags:

Name: The name of the alarm tag, typically <tag>.<alarm type>, e.g. MassFlow.HiHi (read only).
Description: A description of the alarm tag (read-only).
Enabled: Flag to enable the alarm.
Priority: The priority indicates the severity of the alarm and is set according to the following categories:

<table>
<thead>
<tr>
<th>Severity</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>1 - 250</td>
</tr>
<tr>
<td>High</td>
<td>251 - 500</td>
</tr>
<tr>
<td>Medium</td>
<td>501 - 750</td>
</tr>
<tr>
<td>Low</td>
<td>751 - 1000</td>
</tr>
</tbody>
</table>

Delay: Time period in seconds before in alarm is triggered when passing the limit.
Message: The alarm message to be displayed in alarm lists etc.
In Alarm: Flag indicating whether the alarm has been triggered or not (read only).
Settings Limit: The limit to trigger the alarm (analogue value for limit alarms or high/low for state alarms).
Deadband: A tag in alarm will remain so until the value exceeds the deadband setting to eliminate nuisance alarms.
Trigger: Indicates whether in alarm will trigger above or below the limit for limit alarms, or on high (true) or low (false) value for state alarms.
Input source: The name of the actual tag that the alarm has been configured for.
Attributes

The Attributes tab lists various variables (without the more advanced tag features) to be stored for the object:

- **Name**: The name of the attribute (read-only).
- **Description**: A description of the attribute (read-only).
- **Value**: The actual attribute value (editable unless Read-only).
- **Read-only**: Flag whether to allow run-time editing of value or not (set via configuration tool).
- **Time stamp**: Date and time of last change.

4.2.3 Object Explorer

The Object Explorer, available from the Layout view by clicking the arrow icon on the left side, lists all configured objects and areas in a tree structure. An area is a named folder, representing physical areas (Fore, Aft, etc.), systems (Cargo, Ballast etc.) or any other logical categories, defined in the configuration tool. Each object instance is added to an area or a parent object during configuration:

![Figure 18: Object Explorer.](image)

The object's overall alarm status (highest priority) is indicated next to the tag name and propagated up the hierarchical model structure.

Double-click an item to open the corresponding faceplate (if any).
### 4.3 Voyage

The Voyage view takes care of the registration process of voyage data according to EU regulation 2015/757 on monitoring, reporting and verification of emissions from maritime transport, and lists registered voyage data for a selected year.

![Voyage view (for a ro-pax ship).](image)

In general, the following information needs to be registered and calculated per voyage for ships greater than 5000 gross tonnage, transporting cargo or passengers for commercial purposes and calling at least one EU port:

- Fuel type details per consumer
- Fuel consumption per consumer
- Time at sea
- Distance sailed
- Cargo carried
- Transport work
- CO₂ emissions
- Energy efficiency

Note that the available fields and display units for voyage data will depend on the configured ship type, see 5.1.1 for Ship data settings.
4.3.1 Voyage List

Click the heading to select the year to be listed.

The following information is listed for each registered voyage:

- **Voyage No**: Voyage number identification (both letters and digits accepted).
- **Method**: Selected monitoring method (see 5.1.5).
- **Voyage type**: Voyage types available: From EU port, To EU port, Between EU ports, At berth within EU port, Outside EU.
- **Port of departure**: Name of departure port / city.
- **Port of arrival**: Name of arrival port / city.
- **Start time**: UTC date and time when the voyage starts.
- **End time**: UTC date and time when the voyage ends.
- **Time at sea**: Total time period when the ship is at sea.
- **Cargo**: Total mass of the cargo carried. Not for passenger ship. Cargo at arrival for LNG carriers.
- **Passengers**: Number of passengers carried. Only for passenger and ro-pax ship.
- **Distance**: Total distance sailed during the voyage.
- **Transport work**: Cargo transport work carried out during the voyage (see 9.1.6 for details). Not for passenger ship.
- **Transport work**: Passenger transport work carried out during the voyage (see 9.1.6 for details). Only for passenger and ro-pax ship.
- **Total fuel**: Total fuel consumption during the voyage.
- **Total CO2**: Total CO2 emissions during the voyage (see 9.1.3 for details).
- **Total SOx**: Total SOx emissions during the voyage (see 9.1.4 for details).
- **EEOI**: Energy Efficiency Operation Index for cargo transport (CO2 emissions per transport work) for the entire voyage (see 9.1.7 for details). Not for passenger ship.
- **EEOI**: Energy Efficiency Operation Index for passenger transport (CO2 emissions per transport work) for the entire voyage (see 9.1.7 for details). Only for passenger and ro-pax ship.
- **TOTAL**: A summary row for the entire year (until now) is displayed at the end of the voyage list.

Click the navigation buttons to show first, previous, next, last page if the list span across multiple pages.

By expanding a voyage item via the plus icon, further summary details become visible:

**Fuel & Emission**
Summary of the actual fuel types used and corresponding emissions during the voyage.

**Fuel Consumption**
Voyage fuel consumption details, split into sea / berth parts, with sea part further split into cargo / passenger transport for ro-pax ships.
CO₂ Emissions  CO₂ emissions split into sea / berth parts, with sea part further split into cargo / passenger transport for ro-pax ships.

Efficiency  Average efficiency calculations as described in section 9.1.7. No cargo efficiency for passenger ship. Passenger efficiency is only for passenger and ro-pax ship.

EEOI  The Energy Efficiency Operation Index (CO₂ emissions per transport work) for the entire voyage is highlighted. No cargo efficiency for passenger ship. Passenger efficiency is only for passenger and ro-pax ship.

Voyages in the list can be added, edited, deleted and imported / exported via file, further described in the following.

When the cursor is moved over a voyage list row, a toolbar is visible:

- **Click to edit an existing voyage (see 4.3.2).**
- **Click to preview a voyage report for the selected row (see 4.4.4).**
- **Click to confirm and delete the selected voyage.**
- **Export**  Click to export (backup) the voyage list to xml file.
- **Import**  Click to import a voyage list from file.
- **Add**  Click to register and add a new voyage to the list (see 4.3.2).
4.3.2 Voyage Details

Before registering new voyages, a global monitoring method must be specified in the Application Settings (see 5.1.5). Based on the selected method, a corresponding voyage details window will appear. Note that each voyage registration will be based on the selected monitoring method at the time of creation. If the global monitoring method is changed, this will only affect subsequent voyage registrations.

The following monitoring methods are covered:

**Method A: BDN and periodic stocktakes of fuel tanks**

This method is based on the quantity and type of fuel as defined on the BDN combined with stocktakes of fuel tanks based on tank readings. The fuel at the beginning of the period, plus deliveries, minus fuel available at the end of the period and de-bunkered fuel together constitute the fuel consumed over the period.

**Method B: Bunker fuel tank monitoring on-board**

This method is based on fuel tank readings for all fuel tanks on-board. The tank readings shall occur daily when the ship is at sea, and each time the ship is bunkering or de-bunkering. The cumulative variations of the fuel tank level between two readings constitute the fuel consumed over the period.

**Method C: Flow meters for applicable combustion processes**

This method is based on measured fuel flows on-board. The data from all flow meters linked to relevant CO₂ emission sources shall be combined to determine all fuel consumption for a specific period.

Each voyage consists of a number of required events. Additional optional events can be added, depending on the selected monitoring method:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Event</th>
<th>Type</th>
<th>Method A</th>
<th>Method B</th>
<th>Method C</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏴</td>
<td>Start / Left berth</td>
<td>Required</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🌅</td>
<td>Arrived at berth</td>
<td>Required</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🛡</td>
<td>End</td>
<td>Required</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🚰</td>
<td>Sea passage interrupted</td>
<td>Optional</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🚰</td>
<td>Sea passage recommenced</td>
<td>Optional</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🚞</td>
<td>Cargo transfer</td>
<td>Optional</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🛡</td>
<td>Bunkering</td>
<td>Optional</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🚰</td>
<td>De-Bunkering</td>
<td>Optional</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>🌅</td>
<td>Noon report</td>
<td>Required</td>
<td></td>
<td></td>
<td>x</td>
</tr>
<tr>
<td>🌅</td>
<td>Fuel type changed</td>
<td>Optional</td>
<td></td>
<td></td>
<td>x</td>
</tr>
</tbody>
</table>

1) Complete pair of events must be registered.
2) Required daily between Left / Arrived at berth.
Figure 21: Typical voyage events.

It is assumed that the ship immediately leaves berth when a new voyage starts, and that the “At berth” contribution to the total fuel consumption and emissions will be registered at the end of each voyage (and accounted for only for voyages into or within EU).

Several voyage summary data are calculated based on the registered voyage events:

**Distance sailed**
Total distance in nautical miles from berth-to-berth, i.e. between the Left berth and Arrived at berth events.

**Time at sea**
Total time between Left berth and Arrived at berth, excluding any Sea passage interrupted / recommenced time periods.

**At berth**
Time period between the Arrived at berth event and the registered End time of the current voyage (usually the Start of next voyage).

New (or existing) voyages will be verified according to predefined coherency check limits (see 5.1.5).

Note that detailed mouse-over tooltips and information texts are available for several input fields by moving the pointer over its trigger area:

<table>
<thead>
<tr>
<th>Port</th>
<th>Departure</th>
<th>Arrival</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cargo [Ton]</td>
<td>Los Angeles</td>
<td>Liverpool</td>
</tr>
<tr>
<td>Passengers [#]</td>
<td>34,000</td>
<td>A port of call means the port where ship stops to load or unload cargo or to embark or disembark passengers</td>
</tr>
<tr>
<td></td>
<td>0</td>
<td>A port of call means the port where ship stops to load or unload cargo or to embark or disembark passengers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Stops for refuelling obtaining supplies, relieving crew, dry-docking, etc. is not considered a port of call</td>
</tr>
</tbody>
</table>

Figure 22: Example mouse-over tooltip.

The details window for new or existing voyages consists of a number of input fields, as well as an event list for registration of various events occurring during the voyage. The window will be similar for all monitoring methods, except for the events part:
**Figure 23:** Voyage details window (Ro-pax ship).

**Details**

**Voyage No**
Enter the voyage number identification. Both letters and digits are accepted. It is not possible to save an already existing id.

**Voyage type**
Select among available voyage types:
- From EU port
- To EU port
- Between EU ports
- At berth within EU port
- Outside EU

**Port**
Enter name of departure and arrival port / city. Note that when typing in a name, a selectable combo box is shown with matching names already registered to avoid typing mistakes.

**Cargo**
Enter the total amount of cargo carried on this voyage. Not for passenger ship. Cargo at arrival for LNG carriers.

**Passengers**
Enter the number of passengers on this voyage. Only for passenger and ro-pax ship.

**Passenger split**
Enter the percentage split between fuel consumption related to passenger transport (vs. cargo transport). If no value is entered, the split is calculated based on an average weight of 75 kg per passenger. Only for ro-pax ship.
**Distance sailed**

Enter total distance sailed during the voyage. Note that if automated NMEA input has been configured, the distance sailed is loaded automatically by clicking **Load**.

**Time at sea**

Time at sea is calculated based on the registered UTC date and time of the Left berth and Arrived at berth events (see Figure 21).

**Events**

The event list initially shows required and optional events added, depending on the selected monitoring method.

- **Add**
- **Refresh**

  Click to add optional events.
  Method C: This command will load automated history data (if any) indicated by **green** background for distance sailed and total fuel of each consumer and overwrite corresponding manual data registered. The loaded data can be manually modified. Note that all fuel type changes performed in run-time within the actual time period are listed as suggested fuel type changed events.

When the cursor is moved over an event row, a toolbar is visible:

- **Click** to open edit window for selected event (if available).
- **Click** to confirm and delete the selected event (if possible).
  Method C: Click to load automated history data (if any) for the selected event. The loaded data can be manually modified.

Event details are further described in 0.

**Timeline**

A timeline with icons for each of the registered events will be displayed at the bottom of the registration window.

- **Save**

  Press the button to save the registered voyage data. Note that error messages will be displayed when trying to save inconsistent or missing data.
4.3.3 Event Details

All events are configured with an event time:

**Time [UTC]** Enter the UTC date and time of the actual event, click to select from calendar control.
**Event** Name of the event.

In addition, the following information is registered per event, depending on the selected monitoring method:

- **Left berth, Arrived at berth, End**

**Method A: BDN and periodic stocktakes of fuel tanks**

(Fuel type) Enter the total remaining quantity (mass) of each fuel type in the specified display unit at the event time specified. See 5.1.2 for customization of relevant fuel types.

**Method B: Bunker fuel tank monitoring on-board**

Fuel type Select fuel type at the Left berth event for tanks defined. The fuel type of each tank is assumed unchanged until any bunkering events (into empty tanks).
Remaining Enter the total remaining quantity (mass) in each fuel tank in the specified display unit at the event time specified. See 5.1.5 for definition of fuel tanks.

**Method C: Flow meters for applicable combustion processes**

Fuel type Selected fuel type for each consumer at the time specified.
Total The total consumed fuel (mass) for each consumer until the time specified.

**Sea passage interrupted, Sea passage recommenced**

No additional input.
Cargo transfer

**Figure 24: Cargo transfer details window.**

**Distance sailed**
Distance sailed when the event occurred.

**Cargo transferred**
The amount of cargo transferred to (positive number) or from (negative number) the ship.

**Description**
Optional description of the cargo transfer event.

**Save**
Click to save and close the event detail window.

**Bunkering, De-Bunkering**

**Method A: BDN and periodic stocktakes of fuel tanks**

**Figure 25: Bunkering input (method A).**

**Fuel type**
Enter the delta mass imported (green positive number) or exported (red negative number) of each relevant fuel type in the specified display unit at the event time specified.
Method B: Bunker fuel tank monitoring on-board

![New Bunkering event window](image)

**Figure 26: Bunkering details window (method B).**

<table>
<thead>
<tr>
<th>Description</th>
<th>Optional description of the (de)bunkering event.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tank</td>
<td>Select one or more tanks where (de)bunkering has taken place.</td>
</tr>
<tr>
<td>Remaining before</td>
<td>Enter the remaining mass before the (de)bunkering event in relevant tanks.</td>
</tr>
<tr>
<td>Remaining after</td>
<td>Enter the remaining mass after the (de)bunkering event in relevant tanks.</td>
</tr>
<tr>
<td>Fuel type</td>
<td>Bunkering only: Select the fuel type bunkered.</td>
</tr>
<tr>
<td>Save</td>
<td>Click to save and close the event detail window.</td>
</tr>
</tbody>
</table>

**Noon report**

Method B: Bunker fuel tank monitoring on-board

![Noon report input](image)

**Figure 27: Noon report input (method B).**

<table>
<thead>
<tr>
<th>Time [UTC]</th>
<th>Event</th>
<th>T01 Fuel type</th>
<th>Remaining [Ton]</th>
<th>T02 Fuel type</th>
<th>Remaining [Ton]</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.11.2016 22.00</td>
<td>Left berth</td>
<td>DMA</td>
<td>5 000,00</td>
<td>RMA 30</td>
<td>7 000,00</td>
</tr>
<tr>
<td>18.11.2016 17.00</td>
<td>Noon report</td>
<td></td>
<td>3 500,00</td>
<td></td>
<td>6 400,00</td>
</tr>
</tbody>
</table>

**Remaining**

Enter the total remaining quantity (mass) in each fuel tank in the specified display unit at the event time specified. See 5.1.5 for definition of fuel tanks.
**Fuel type changed**

Method C: Flow meters for applicable combustion processes

<table>
<thead>
<tr>
<th>Time [UTC]</th>
<th>Event</th>
<th>MainEngine</th>
<th>Total [Ton]</th>
<th>AuxEngine</th>
<th>Total [Ton]</th>
</tr>
</thead>
<tbody>
<tr>
<td>09.03.2016 23:00</td>
<td>Left berth</td>
<td>DMB</td>
<td>12.214.811.43</td>
<td>DMC</td>
<td>3.932.693.60</td>
</tr>
<tr>
<td>12.03.2016 10:39</td>
<td>fuel type changed (unchanged)</td>
<td>DMX</td>
<td>3.932.906.88</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Figure 28: Fuel type changed input (method C).*

**Fuel type**

Selected fuel type for each consumer at the time specified (or keep it unchanged).

**Total**

The total consumed fuel (mass) for each consumer until the time specified.
4.4 Report

In the Report view, the user can generate and preview various reports based on editable report parameters for the actual report type:

![Example report view](image)

*Figure 29: Example report view.*

The report parameters vary depending on the selected report type parameter.

**Type**

The following report types are available:

- Emission Report
- Fuel Consumption Report
- Bunker Report
- Voyage Report

![Selectable reports](image)

*Figure 30: Selectable reports.*

Show

Press the button to generate and preview a report in the report viewer.
4.4.1 Report Viewer

The report viewer includes a toolbar for navigation, print, export etc. of the report.

1. **Back**   
   Navigate back in history.

2. **Forward**   
   Navigate forward in history.

3. **Stop**   
   Stop refreshing / rendering.

4. **Refresh**   
   Refresh report.

5. **First**   
   Navigate to first page.

6. **Previous**   
   Navigate to previous page.

7. **Current**   
   Navigate to page / current page.

8. **Next**   
   Navigate to next page.

9. **Last**   
   Navigate to last page.

10. **Setup**   
    Open page setup.

11. **View**   
    Toggle between print / interactive view.

12. **Print**   
    Print report.

13. **Export**   
    Export report to various file formats (pdf, csv, excel, word etc.).

**Zoom**   
Use the zoom slider or percentage selector in the bottom right corner to zoom in or out.

![Zoom slider]

**Logo**   
The reports include a custom company logo when an image file named Logo.png has been copied to \ProgramData\Krohne\Resources\.

**Email**   
Click to popup a window for sending the currently displayed report by email attachment to selected recipients.
4.4.2 Email

The user can send reports by email to selected recipients. Note that sufficient email credentials must be specified as described in section 5.1.3, otherwise an error message is displayed when trying to open this window:

![Send email window.](image)

To
Enter email address of recipients separated by semi-colon.

Cc
Enter email address of copy recipients separated by semi-colon.

Bcc
Enter email address of carbon copy recipients separated by semi-colon.

Subject
Modify default subject / heading.

Message
Modify default mail message body text.

Attachments
Select report attachments. Note that only the pdf attachment is selected by default, while csv and xlsx formats are also available.
4.4.3 Fuel Consumption Report

The Fuel Consumption Report reports the total fuel consumption and emission data per consumer and fuel type for a selected time period, and includes the following report parameters:

Start time Enter start date and time of the reporting period.
End time Enter end date and time of the reporting period.

4.4.4 Voyage Report

The Voyage Report reports voyage data, transport work and energy efficiency, total fuel consumption and emission data per consumer and fuel type for a specific voyage, and includes the following report parameters:

Year Select a year to list available voyages.
Voyage Select the voyage you want to report (if any).
4.4.5 Emission Report

The Emission Report is an annual report according to EU regulation 2015/757 for Monitoring, Reporting and Verification (MRV) of fuel consumption and emissions, based on the following report parameters:

- **Reporting period**: Select a year to list available voyages.
- **Responsible entire period**: Flag telling if the Company is responsible for the entire reporting period.
- **Responsible from**: In case Company is not responsible for entire year (change of company etc.), specify the first date of responsibility.
- **Responsible to**: Specify the last date of responsibility (or last day of the year).
- **Status**: Select among available report statuses (Draft, Final etc.)
- **Show voyage list**: Flag telling whether a complete voyage list will be displayed in the report.
4.4.6 Bunker Report

Selecting Bunker Report lists all the performed bunker batches in the system and enables viewing or printing a bunker report based on the following report parameter:

**Year**

Select a year to list performed bunker batches within selected year.
4.5 History

In the History view, the user can trend historical data for tags configured to be stored in the historian database:

![History view](image)

**Figure 37: History view.**

- **Search**: Type in any part of the name to filter the list of available tags, clear to show entire list.
- **Add**: Double-click a name in the list of available tags to show the trend. If the maximum number of simultaneous trends is exceeded, please remove another trend first.
- **Remove**: Click the remove icon next to the legend at mouse-over to remove a trend.
- **From**: Enter the minimum time frame limit or click to select from calendar control.
- **To**: Enter the maximum time frame limit or click to select from calendar control.
- **Time period**: Select among predefined time periods.
- **Export**: Click to export the trends to pdf file.

Tag name, colour and display unit is indicated in the legend. A cursor can be moved along the trend, showing name, value and display unit for each visible trend at a selected time.

**Note that the availability of data stored in the historian database will depend on whether history has been enabled for the actual tag, as well as the configured storage interval (e.g. every second) and duration, i.e. the time period where data is stored before being overwritten, all set via the configuration tool.**
5 MENU

The top area includes a menu bar to access various windows and utilities:

![Figure 38: Top menu.]

5.1 Settings

Various global settings for the application are registered via the Settings window:

![Figure 39: Settings window (Ship data, Fuel types, Email and Report views).]
5.1.1 Ship data

The ship data settings include key data for the vessel, as well as responsible organizations, and are used in various reports etc.

Figure 40: Ship data settings.

**IMO Id**
The vessel’s unique identification number by the International Maritime Organization (IMO).

**Ship name**
The name of the ship.

**Ship type**
The actual type of ship, selectable from a list of available definitions.

**Flag state**
The state under whose laws the vessel is registered or licensed.

**Port of registry**
The port in which a vessel is registered.

**Technical efficiency**
Energy Efficiency Design Index EEDI or Estimated Index Value EIV.

**Ice class**
A notation assigned to the ship, showing that the ship has been designed for navigation in sea-ice conditions.

**Ship owner**
The owner of the ship.

**Company**
Any organization or person which has assumed the responsibility for the operation of the ship from the ship owner.

**Contact person**
Appointed contact person within the company.

**Verifier**
Independent and competent legal entity, accredited by national accreditation bodies, to verify MRV monitoring plan and annual emission reports.

[Edit] / Name
Click any of the roles involved (Ship owner, Company, Contact Person or Verifier), the corresponding Contact Details window is opened for input of further data:
Figure 41: Contact details window.
5.1.2 Fuel types

A custom fuel type definitions library is administrated via the fuel type settings, listing the following information:

![Figure 42: Fuel type settings.](image)

- **Active**: When this checkbox is turned on, the fuel type will be available for selection in dropdown menus etc. throughout the application, otherwise it will be hidden. To edit a fuel type definition, turn off the Active flag and edit in relevant cells.

- **In use**: A lock icon indicates that the fuel type is currently in use and selected for one or more of the fuel consumers (blue font), or it has been selected in previous voyage registrations (grey font), and it can therefore not be edited.

- **Colour**: The selected colour is used in dashboards, diagrams etc. throughout the application for the actual fuel type.

- **Name**: The name of a defined fuel type.

- **Description**: A description of the fuel type.

- **Category**: Fuel type category.

- **CO2 Cf**: CO₂ emission factor, emitted mass of CO₂ per fuel consumed [mass CO₂/mass Fuel].

- **Sulphur content**: Sulphur content of the actual fuel type [%].

- **New**: Click to add a new row, then enter data in the highlighted (last) row. If the data does not meet validation requirements, an error message is displayed.
5.1.3 Email

By entering valid email settings, the user will be able to send reports by email when an internet connection is available.

![Email settings](image)

*Figure 43: Email settings.*

**From**
E-mail address appearing as the sender of the e-mail.

**Alias**
Alias name of the sender.

**Host**
Name or IP address of the host used for SMTP transactions.

**Port**
Port number to be used.

**Enable SSL**
Flag whether the SMTP client uses Secure Sockets Layer (SSL) to encrypt the connection or not.

**Default credentials**
Flag whether to use the user’s default network credentials instead of the ones specified here.

**User**
Credentials username.

**Password**
Credentials password.

**Domain**
Credentials domain (if any).
5.1.4 Automatic reports

Automatic generation and distribution of various reports at predefined intervals can be administrated via the Report tab.

Note that valid email settings must be entered (see 5.1.3) before automatic reports will be distributed via email.

![Automatic report settings](image1)

**Figure 44: Automatic report settings.**

Add

Click to add a new automatic report schedule:

![Report schedule details](image2)

**Figure 45: Report schedule details.**

- **Report**: Select the report type among available reports to be scheduled.
- **Trigger**: Select the time interval (frequency) between each new report triggered.
- **Start**: Select the start date and time for generation of the first automatic report. Type in or select via a calendar control.
Recipients

Type in the email address of one or more recipients who will receive the report attached via e-mail. Separate addresses by space, comma or semi-colon. Click icon to remove a recipient.

OK

Click to save the report schedule to a list of automatic report definitions.

When the cursor is moved over a row, a toolbar is visible:

Click to edit an existing report schedule.
Click to confirm and delete the selected report schedule.

5.1.5 Application settings

Typical global settings for the entire application are specified in the Application tab:

![Application settings](image)

**Figure 46: Application settings.**

### Monitoring methods

**Method A/B/C/D**  Select the monitoring method to be used for calculation of fuel consumption, emissions and efficiency per voyage. According to the EU MRV regulation 2015/757, the following methods can be used:

- Method A: BDN and periodic stocktak of fuel tanks
- Method B: Bunker fuel tank monitoring on-board
- Method C: Flow meters for applicable combustion processes
- Method D: Direct CO₂ emissions measurement

Methods A, B and C are covered by the EcoMATE™ MRV Module at this stage.

**Uncertainty**  Associated uncertainty level of each monitoring method.
Fuel tanks

Define the fuel tanks appearing when registering voyages based on method B:

- **Add**: Click to add a new fuel tank.
- **Name**: Enter (edit) fuel tank name.
- **Description**: Enter (edit) fuel tank description.

Coherency checks

A number of coherency checks have been defined, triggered when the user tries to save voyage/event registrations outside defined limits:

- **Maximum speed**: Check based on a voyage's Distance sailed and Time of Left berth and Arrived at berth (method A/B/C).
- **Maximum cargo**: Checks the registered Cargo carried on a voyage (method A/B/C).
- **Empty tank threshold**: Checks the Bunkering event (method B) when a new Fuel Type is selected for a tank with Remaining mass above the Empty tank limit.
- **Fuel threshold**: Checks that the cumulative variations between two readings (without any Bunkering/De-bunkering in between) are below the Fuel threshold limit (method A/B).

Backup settings

EcoMATE™ can be configured to perform daily backup of config file and historical data:

- **Enabled**: Select to enable daily backup.
- **Folder**: Select folder to place the backups.

Cloud synchronization settings (optional)

EcoMATE™ can be supplied with optional cloud synchronization function:

- **Enabled**: Select to enable cloud synchronization.
- **Access key**: Provided by KROHNE Marine.

Remaining items are info on cloud synchronization status.

### 5.2 Help

The Help menu gives access to available manuals, drawings and web pages, both locally and via the internet (if available), displayed in a web browser with print, save, zoom, find capabilities etc. by right-clicking the content.

#### 5.2.1 User Manual

An electronic version of this User Manual is available. Press Ctrl + F to search for a specific topic.
5.2.2 About

The About view displays various information for the current software installation:

Figure 47: Example view from User Manual.

Figure 48: About view.
5.3 Night mode

By clicking symbol \( \odot / \odot \) you can toggle between day and night mode.

*Figure 49: Example view of night mode.*
6 OBJECTS

A system configuration will be based on a number of equipment and logic objects, depending on the scope of delivery. Common principles like layout drawings, interactive symbols and corresponding popup faceplates are described in chapter 4.2. In the following, key run-time variables of various objects are listed for reference.

6.1 Mass Flow Meter

This object is configured to represent flow meters in the system:

![Mass Flow Meter symbol and faceplate.](image)

- **Mass Flow**: Momentary mass flow in display units (measured).
- **Density**: Momentary density in display units (measured).
- **Temperature**: Momentary temperature in display units (measured).
- **Air Index**: An index describing the presence of two-phase flow (measured).
Drive Gain  The power output of the sensor system oscillator (measured)
S1 Voltage  Sensor signal 1 (measured).
S2 Voltage  Sensor signal 2 (measured).
Status Register  Flow meter status (measured).

6.2 Fuel Consumer

This object is configured to represent fuel consumers in the system.
Layout view will depend on the configuration:

![Fuel Consumer symbol and faceplate.](image)

**Figure 51: Fuel Consumer symbol and faceplate.**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fuel Type</td>
<td>Select current fuel type definition for the consumer (see 0).</td>
</tr>
<tr>
<td>Momentary Fuel</td>
<td>Total momentary fuel in display units based on custom calculation (see 6.5) from various flow meters.</td>
</tr>
<tr>
<td>Rotation Speed</td>
<td>Rotation speed in RPM of the fuel consumer. Only for rotating equipment.</td>
</tr>
<tr>
<td>Momentary CO₂</td>
<td>Total momentary CO₂ emission in display units based on total momentary fuel and corresponding fuel type.</td>
</tr>
</tbody>
</table>
**Momentary SOx**  Total momentary SOx emission in display units based on total momentary fuel and corresponding fuel type.

**Momentary NOx**  Total momentary NOx emission in display units based on total momentary fuel and corresponding fuel type.

**Total Fuel**  Total fuel count in display units based on custom calculation (see 6.5) from various flow meters. Can be counted and reset via separate totalizer (see 6.4).

**Total CO₂**  Total CO₂ emission in display units based on total fuel and corresponding fuel type.

**Total SOx**  Total SOx emission in display units based on total fuel and corresponding fuel type.

**Total NOx**  Total NOx emission in display units based on total fuel and corresponding fuel type.

**Is Consuming**  Status, depending on whether the momentary fuel is greater than the configured minimum flow cut-off limit or not.

### 6.3 Consumer Total

This object summarises the overall momentary and total fuel consumption and emissions for all configured consumer (see 6.2) in the system:

*Figure 52: Consumer Total symbol and faceplate.*
6.4 Totalizer - Optional

A totalizer object is modelled whenever a resettable counter is required:

**Start / Stop**
Click to start counting the configured input value from zero into the totalizer value. When stopping a totalizer, a new row is added to the totalizer list of previous counts performed.

**Total Value**
The configured input value to be counted.

**Totalizer Value**
The counted total value until now and display unit for the current totalizer.

**Duration**
The total duration of the current totalizer is indicated by an analogue clock and digital format (total hours:minutes:seconds).

**Totalizer List**
A list of previous totalizers executed, listing the start and end time as well as the total value and unit. Click to confirm and delete the selected totalizer item from the list.

---

Figure 53: Totalizer symbol and faceplate.
Is Counting: Status **Counting** or **Inactive**, depending on whether the totalizer is counting (has been started) or not.

### 6.5 Calculation

A calculation object is required to execute calculations based on custom formulas:

![Calculation Symbol]

**C1 – C9** Configurable input source values to be used in the calculation formula.

**Formula** Calculation formula, e.g. C1 + C2 – C3

**Result** The calculated value and display unit.

### 6.6 Selector

The selector object is configured to select a value based on multiple selection criteria and a corresponding expression:

![Selector Symbol]

**S1 – S3** Configurable input source values to be used as selection criteria in the expression.

**Expression** The expression formula to be verified, e.g. S1 > S2.

**C1** The configurable input source value to be selected if the expression is true.

**C2** The configurable input source value to be selected if the expression is false.

**Result** The selected value (C1 or C2) and display unit.

### 7 GRAPHICAL ELEMENTS

A set of standard graphical elements are used for various objects throughout the application in views, symbols, popup faceplates etc.
7.1 Radial Gauge

This element includes an animated gauge between the minimum and maximum measurement range, a tag quality indicator, a description of the tag represented, a live value and the configured display unit and format as well as the alarm status:

![Figure 56: Radial gauge example.](image)

When the tag is in manual mode, a border is visible around the numeric number, indicating that a manual value can be typed in for testing purposes etc.

By moving the mouse cursor over the numeric value, a mini trend is displayed showing historical data (if any).

7.2 Vertical Gauge

This element displays the same information as the Radial Gauge (see 7.1) with the following layout:

![Figure 57: Bar graph example.](image)
7.3 Alarm Status

An alarm status symbol is indicated for tag values when one or more of its alarm definitions have been enabled and are in alarm status. The icon of the most severe alarm with highest priority is displayed when multiple alarms are active:

<table>
<thead>
<tr>
<th>Severity</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>1 - 250</td>
</tr>
<tr>
<td>High</td>
<td>251 - 500</td>
</tr>
<tr>
<td>Medium</td>
<td>501 - 750</td>
</tr>
<tr>
<td>Low</td>
<td>751 - 1000</td>
</tr>
</tbody>
</table>

Also, an alarm status summary is displayed for various objects, counting the number of alarms present for individual tags, objects, areas or in total, grouped by severity / priority:

![Alarms](image)

*Figure 58: Number of critical, high, medium and low priority alarms, grey if none.*
8 HOW TO

In this chapter, typical step by step procedures are listed for common run-time operations. For questions regarding off-line configuration, please refer to the configuration manual for details.

8.1 Popup an object faceplate

- Select the Layout tab to navigate to the layout view.
- Load the relevant layout drawing via the heading combo box (e.g. Main).
- Click the relevant object symbol to popup the corresponding faceplate (e.g. Main Engine).
- Alternatively, open the Object Explorer via the left side arrow and double-click an item.

![Figure 59: Layout symbol with popup.](image)
8.2 Edit alarm settings

Figure 60: Alarm settings.

- Popup the relevant faceplate (see 8.1).
- Select the Service tab.
- Select the Alarms category.
- Check the Enabled flag of the alarm.
- Enter the Limit that will trigger the alarm. Analogue value for limit alarms or high/low for state alarms.
- Enter the Deadband value: A tag in alarm will remain so until the value exceeds the deadband setting to eliminate nuisance alarms.
- Select Trigger type: Indicates whether in alarm will trigger above or below the limit for limit alarms, or on high (true) or low (false) value for state alarms.
- Enter Delay: Time period in seconds before in alarm is triggered when passing the limit.
8.3 How to get started

A number of Quick Guides explaining various “How to” procedures, referenced below, are available from the application via the top menu Help > Quick Guides. The complete User Manual is found under Help > User Manual.

1. Install the EcoMATE™ software and license key (if not already pre-installed) and start the application. See Quick Guide How to install or upgrade the software and renew a license key.
2. Specify custom ship data. Click the Settings menu, select the Ship Data tab view, enter key data and save. Note that the ship data will be required for the annual Emission Report.
3. Configure relevant fuel types as described in Quick Guide How to edit and change fuel type for a consumer.
4. Analyse historical data (if available) like fuel consumption, emissions and efficiency as required. See Quick Guide How to trend and analyse historical data.
5. It is recommended to register voyages regularly throughout the year. See Quick Guides How to register or edit a voyage (method A/C), depending on the selected monitoring method.
6. Generate relevant reports when required. See Quick Guide How to create and distribute a report.
8.4 How to install or upgrade the software and renew a license key

Minimum required operating system is Windows 7 or newer. Recommended screen resolution is 1920x1080. Note that the dialogues described in the following may be different the first time the software is installed compared to later upgrades.

1. Double-click the install (executable) file to start installation of the software.

2. Confirm that you want to allow this app to make changes to the computer.
3. Enter Administrator credentials if prompted for.

4. Click [Install] to confirm installation of the new software version.
5. Click **Next** to close the applications (if any), using the files to be updated.

6. Wait for the software installation to complete.

7. Click **Finish** to exit when the setup wizard has completed.
8. Start the application by double-clicking the EcoMATE™ Client icon.

9. If prompted for a software license, please enter the licence key received and press OK or contact KROHNE Marine to request a valid key based on your unique Installation ID. Note that you can try the software for a trial period of 30 days.

10. Press OK to open ship data settings the first time.

11. Select Ship type.
12. Click Save.
8.5 How to edit and change fuel type for a consumer

A number of predefined fuel types are available by default, and custom definitions can be added. If the Dashboard view with run-time widgets is not available in your version of EcoMATE™, any updated and new fuel types will still take effect during manual voyage registrations.

1. Click the Settings menu to open the Settings window.
2. Select the Fuel types tab.
3. Uncheck the Active flag (if not in use and locked for editing by one or more consumers or previous voyage registrations) to edit an existing fuel type.
4. Click New to add a new fuel type definition.
5. Select associated display colour, type in name and description, choose fuel category and enter emission factor and sulphur content for the fuel type.
6. Check the Active flag to make the fuel type available for run-time selection.
7. Click Save.
8. Select the Dashboard tab view (if available).
9. Change the currently selected fuel type for relevant consumers and confirm.
8.6 How to register or edit a voyage (method A)

It is assumed that monitoring method A (BDN and periodic stocktakes of fuel tanks) has been selected in Settings > Application.

1. Click the Voyage tab to view the voyage list.
2. Click the year heading to change.
3. Click Add to add a new voyage.
4. Click edit (visible on row mouse-over) to edit an existing voyage.
5. Enter voyage details:
   - Voyage No.
   - Voyage type.
   - Departure and Arrival Port.
   - Cargo (not for passenger ship, at arrival for LNG carrier).
   - Number of Passengers (only for passenger and ro-pax ship).
   - Passenger split, i.e. the percentage contribution of passenger vs. cargo transport (only for ro-pax ship).
   - Type in Distance sailed for the entire voyage.
6. Complete the event list by selecting UTC Time, and enter remaining mass of each fuel type.
7. Click Add to add optional events (if any).
8. Click Save to add / save voyage registration to the voyage list.
8.7 How to register or edit a voyage (method B)

It is assumed that monitoring method B (Bunker fuel tank monitoring on-board) has been selected in Settings > Application.

1. Click the Voyage tab to view the voyage list.
2. Click the year heading to change.
3. Click Add to add a new voyage.
4. Click edit (visible on row mouse-over) to edit an existing voyage.
5. Enter voyage details:
   - Voyage No.
   - Voyage type.
   - Departure and Arrival Port.
   - Cargo (not for passenger ship, at arrival for LNG carrier).
   - Number of Passengers (only for passenger and ro-pax ship).
   - Passenger split, i.e. the percentage contribution of passenger vs. cargo transport (only for ro-pax ship).
   - Type in Distance sailed for the entire voyage.
6. Complete the event list by selecting UTC Time, and enter initial Fuel type and remaining mass in each fuel tank.
7. Click Add to add optional events (if any).
8. Click Save to add / save voyage registration to the voyage list.
8.8 How to register or edit a voyage (method C)

It is assumed that monitoring method C (Flow meters for applicable combustion processes) has been selected in Settings > Application.

1. Click the Voyage tab to view the voyage list.
2. Click the year heading to change.
3. Click Add to add a new voyage.
4. Click edit (visible on row mouse-over) if you want to edit an existing voyage.
5. Enter voyage details:
   - Voyage No.
   - Voyage type.
   - Departure and Arrival Port.
   - Cargo (not for passenger ship, at arrival for LNG carrier).
   - Number of Passengers (only for passenger and ro-pax ship).
   - Passenger split, i.e. the percentage contribution of passenger vs. cargo transport (only for ro-pax ship).
   - Type in Distance sailed for the entire voyage.
6. Complete the event list by selecting UTC Time, and enter initial Fuel type and fuel consumption totals for each consumer.
7. Alternatively, click Refresh to read automatic history data (if any), indicated by green background, and overwrite any corresponding manual data registered.
8. Click Add to add optional events (if any).
9. Click Save to add / save voyage registration to the voyage list.
8.9 How to create and distribute a report

It is assumed that sufficient email credentials have been specified in Settings > Email.

1. Select the Report tab view.
2. Select relevant Report type.
3. Enter corresponding report parameters.
4. Click Show to preview report.
5. Click print to open a print dialogue window and print report.
6. Click save to export report to various file formats (pdf, excel, word, csv).
7. Click Email to send report by email attachment to selected recipients:

- Enter email address of (To, Cc and Bcc) recipients, separate by space, comma or semi-colon. Click x to remove.
- Modify default Subject and Message text if relevant.
- Select Attachments (pdf format is selected by default).
8. Click Send.
8.10 How to trend and analyse historical data

It is assumed that relevant tags have been configured to store data to the history database.

1. Select the History tab view.
2. Type in any part of the name in the search field to filter the list of available tags, clear to show entire list.
3. Double-click a name in the list of available tags to show/add the trend.
4. Click x next to the legend to remove a trend.
5. Enter the time frame From and To limits, or use the mouse to click & drag the trend.
6. Alternatively, select among predefined Time periods, or use the mouse scroll wheel to zoom in/out in time.
7. Move cursor along the trend to see numeric values for each trend.
8. Click Export to save trend(s) to pdf file.
8.11 How to monitor and report a bunkering operation

NOTE: Relevant bunkering procedure must accompany this guide.

1. Open bunker window by clicking relevant bunker flowmeter object.
2. Batch info and values displays previous completed bunkering data.
3. Live values are displayed directly from flowmeter.
4. Click Prepare new batch and enter desired free-text info.
5. Select Product based on actual fuel viscosity to be bunkered and click OK.
6. a) Click Begin batch to start monitoring and logging the bunker operation.
   b) Click Cancel batch to cancel inputs from pt.4 and 5. Go back to pt.4.
System is now accumulating and storing data from bunker flowmeter:

7. Batch info and values displays running bunkering data.
8. Live values and trends are displayed directly from flowmeter.
9. When bunkering operation is completed, click End batch.
10. Enter optional comment and click OK.
11. Click tab Batches to see list of completed batches.

12. Latest Bunkering will display on top. Click to open the report in Report tab of main view. Close bunker window.
You will now be able to view, print, save or send the report.
9 APPENDICES

9.1 Appendix 1: Calculations

9.1.1 Energy Efficiency Design Index (EEDI)
Manual design index for new ships as a function of ship type and size of the ship, ref IMO MEPC.215(63) (MEPC, 2012).

9.1.2 Estimated Index Value (EIV)
A simplified version of the EEDI for existing ships.

9.1.3 Momentary CO₂

\[ CO₂ = \sum_{j} Q_j \times C_{Fj} \]

Where

\( Q_j \) = Momentary mass flow of each consumer \( j \)
\( C_{Fj} \) = Fuel mass to CO₂ mass conversion factor of fuel type \( j \)

9.1.4 Momentary SOₓ

\[ SOₓ = \sum_{j} Q_j \times S_{Fj} \times M_x \]

Where

\( Q_j \) = Momentary mass flow of each consumer \( j \)
\( S_{Fj} \) = Sulphur content in fuel type \( j \)
\( M_x \) = Molecular mass ratio

9.1.5 Momentary NOₓ

\[ NOₓ = \sum_{j} Q_j \times C(rpm)_{j} \]

Where

\( Q_j \) = Momentary mass flow of each consumer \( j \)
\( C(rpm)_{j} \) = Fuel mass to NOₓ mass conversion factor of consumer \( j \) as a function of momentary RPM and fuel type.
9.1.6 Transport Work

\[ W = m_{\text{cargo}} \times D \]

Where

\[ m_{\text{cargo}} = \text{Total mass of cargo carried} \]
\[ D = \text{Distance sailed} \]

9.1.7 Average Energy Efficiency

1) Fuel Consumption per Distance

\[ EE1 = \frac{\sum FC_j}{D} \]

2) Fuel Consumption per Transport Work

\[ EE2 = \frac{\sum FC_j}{m_{\text{cargo}} \times D} \]

3) CO₂ Emissions per Distance

\[ EE3 = \frac{\sum FC_j \times C_{Fj}}{D} \]

4) CO₂ Emissions per Transport Work

\[ EEOI = \frac{\sum FC_j \times C_{Fj}}{m_{\text{cargo}} \times D} \]

Where

\[ EEOI = \text{Energy Efficiency Operation Index} \]
\[ FC_j = \text{Mass of each consumed fuel type j} \]
\[ C_{Fj} = \text{Fuel mass to CO₂ mass conversion factor of fuel type j} \]
\[ m_{\text{cargo}} = \text{Total mass of cargo carried} \]
\[ D = \text{Distance sailed} \]
KROHNE – Process instrumentation and measurement solutions

- Flow
- Level
- Temperature
- Pressure
- Process Analytics
- Services

The current list of all KROHNE contacts and addresses can be found at: www.krohne.com